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I Introduction 

I .I. Background 
Granular  resources  are an important construction material in the North. 
Historically,  granular material has been used in the construction of 
roadways, airfield runways,  embankments to support  buildings  and 
other physical structures, and in the construction of drilling pads  and 
temporary offshore exploration  structures in the shallow  waters  of the 
Beaufort Sea. 
Granular  resources  (gravel) in the Mackenzie  Delta  region of the 
Northwest  Territories are limited. Much work has been done  during the 
past  quarter century to  quantify the volumes and quality of the  various 
eskers  (long,  narrow  ridge of coarse gravel deposited  by a stream 
flowing in a decaying glacial ice sheet)  located in the region. 

Historically,  management  of  granular  resources  was the responsibility 
of the Department of Indian and Northern Affairs,  Canada.  As part of 
the lnuvialuit  Land settlement in 1984, however,  much of the granular 
resources in the Mackenzie  Delta region are now  owned by the 
Inuvialuit.  Thus,  management of the resource is now divided between 
the Department  and the lnuvialuit Land Administration. 
One of the key variables in managing the resource is the ability to 
forecast potential demands  on an ongoing  basis. The Granular 
Resources Forecast Model provides for an efficient tool for  archiving 
and  analyzing  these  demands. 
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a 1.2. Forecast Model Overview 
The  primary  objective of the project  was to develop a Microsoft Access 
version  of the model that will allow DIAND and the Inuvialuit Land 
Administration to forecast granular resource  requirements in the 
Western  Arctic  Region. 
The  broad  framework for the model is shown in Figure I. As identified 
above, the model can focus on the past,  present,  and  future. It draws 
this  information from one central data base that will contain information 
pertinent  to  granular  resource  usage. 
The  intent  in  following  this  approach  was to provide a tool that would 
help the various  groups  forecast  granular  resource  usage and help in 
the  management of current  granular  usage. 

Figure 1 - Model Overview 

I .3. Forecast Model  Documentation 
The  Granular  Resource  Forecast ModeP User's  Guide  describes the 
program  and its underlying  basis. It provides  basic  instructions, 
procedures and tips on how to use the tool in an effective  and 
accurate  manner. 

The  user's  guide is intended for people of all experience  levels. The 
information is organized into six  sections.  This introduction gives  an 
overview of the contents and conventions.  Section 2 defines the 
system  requirements and provides  instructions to install and use the 
Granular  Resource  Forecast ModeP. It also gives an overview of the 
menu  structure. Section 3 defines the Data  Management  portion of the 
program,  and Section 4 the analysis half of the program. 
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It is important to understand  the  terms  and notation conventions in this 
user's  guide  before  using the Granular  Resource  Forecast  ModeP. 

I .4.  Conventions 
. 

General 
The  word "choose" is used to select a menu  button. 
Bold type in the text and procedures  indicates  words  or  characters 

Bulleted (e) lists,  such as this one,  provide  information, not 

A numbered list (1, 2, 3 ...) indicates a procedure  with two or  more 

that  are  typed  or  buttons that are  selected. 

procedural  steps. 

sequential  steps. 

Mouse 
The documentation  assumes that you have configured the left 
mouse button as the primary mouse button. 
"Point"  means to position the mouse pointer until the tip of the 
pointer  rests on what you want to point to on the screen.  For 
example,  "Point to the button Add or Update Data." 

"Click"  means to press  and  immediately  release the mouse button 
without  moving the mouse.  For  example, "Click on the button 
named Add or Update Data." 
"Double-click"  means to click the mouse button twice  in  rapid 
succession.  For  example,  "Double-click on the Microsoft Excel icon 
to  start  Microsoft Excel." 

Keyboard 
Key  names match the names  shown on most  keyboards and 
appear in small capital letters.  For  example, the Shift key  appears 
as SHIFT. 

I .5. Technical Support 
NORTH OF 60 ENGINEERING LTD. offers a  variety of support options to 
help  get the most  from the Granular  Resource  Forecast  Modeta.  These 
services  include: 
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Custom  modifications to the model 

Customized  training 
0 Technical  support 

If you encounter a problem or have a question  about the application, 
first look in the printed  documentation. If you cannot find the answer, 
phone or fax NORTH OF 60 ENGINEERING LTD. from 8 a.m. to 5 p.m. 
(Mountain  Time)  Monday through Friday. 
NORTH OF 60 ENGINEERING LTD.  support  services  are  subject to prices, 
terms, and conditions in place at the time the service is required. 
When you call, you should be at your  computer with the Granular 
Resource  Forecast ModeP running.  Be  prepared to give the following 
information: 

rn The version  of  Microsoft  Access you are using. 

The type of hardware and operating  environment you are using. 

The exact  wording  of  any  messages that appeared  on  your 

0 A description of what  happened and what you were  doing when 

NORTH OF 60 ENGINEERING LTD. can be reached  by  phone, fax or email: 

screen. 

the problem occurred. 

Phone: (403) 263 - 2121 
Fax: (403) 263 - 2122 
Email: support@north6O.com 
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2. Getting Started 

2A System Requirements 

The  Granular  Resource  Forecast  Model@ has been  developed  under 
Microsoft  Access  running  on the Windows  operating  system. To use 
the model you need the following  minimum  hardware: 

A  Windows  98/ME/2000/XP  machine  with  Microsoft  Access 

Memory  (RAM)  requirements  for  Microsoft  Access  should  be 

0 Disk  space  depends on the size of the database;  however 

0 A  Microsoft  Windows-compatible printer is optional. 

2000/2002 and Microsoft Excel 2000/2002 installed. 

sufficient to operate the model. 

database size is typically 1 or 2 megabytes. 

- 

2.2. Installing  the Forecast Model 
The  following  *instructions describe how to install the Granular 
Resource  Forecast ModeP on your  computer. Although the model is 
not  copy  protected, Indian and Northern Affairs  Canada, and the 
lnuvialuit Land  Administration  may  make  copies  only for business use. 
For  complete  details, please read the license  agreement  in  Appendix 

'A. 

To install the  Granular  Resource Forecast ModeP: 
1. The model and the database are contained in a single  Microsoft 

Access database file. The file can be copied to any  folder on the 
system using Windows  Explorer. 
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2. To use the help  feature  of the model, the help files must be  copied 
to a folder called GRANMANUAL.  This  folder  must be located in 
the same folder  as the model. 

2.3. File Structure of Model 
The Granular  Resource  Forecast ModeP has  been  developed as an 
application  within  Microsoft  Access so it requires  Access to operate. 
The  installation  procedure  outlined in the previous section copied  one 
file  and  one  folder onto your  hard  drive.  Their  names and function 
within the application are summarized in Table 1. 

FileIFolder  Name 

Folder  containing all the help files GRANMANUAL 
Application and  Database  File GRANULAR.MDB 

Description 

Table 1 - Granular Resource Forecast Model@ Files 

2.4. Starting the Program 
To run the Granular  Resource  Forecast  Model@  application: 
1. Close  any  unnecessary  applications  that may be operating on your 

computer to maximize  memory and system  resources. This is done 
by  selecting Exit fr0.m the File menu  of the applications. 

2. Open the GRANUlAR.MDB file by double  clicking  on the file icon 
in Windows  Explorer, or by  using the File-Open command in 
Microsoft  Access. 

3. The Main Menu will appear: 
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Figure 2 - Main Menu 

2.5. Program Structure 
The Granular  Resource  Forecast Model@ is a database of historical, 
current  and future granular  requirements. The application  has  been 
divided  into two major  components. The first half of the application is 
devoted  to  adding  and  maintaining  information within the database. 
The  details of the database will be discussed in the next  section of the 
User's  Guide. 
The second half of the application is devoted to analyzing the 
information within the database, both from historical and  future 
perspectives. You can,  for  example,  compare actual granular  usage to 
historical  forecasts,  or  usage  by  area,  source  or  quality.  The  analysis 
section  also  allows,  with  limitations, users to define their own criteria to 
study the data. The specifics  on  data  analysis and the various  reports 
that are  available  are  presented in Section 4 of the User's  Guide. 
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3. Granular Usage Database 

3.1 Introduction 
This  section of the User's Guide focuses  on the Granular  Usage 
Database, its makeup and procedures to maintain it. 

As a  user, you access the database  by clicking,on the Quarry Permits 
button on the Main  Menu  (Figure 2). The program will then  present the 
form shown  below. 

Figure 3 - Quarry Permlts Form 
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Information is entered to describe the Permit in terms of when the 
granular material will be used,  an  estimate of the quantity and  type  of 
material  needed  for the project, the location of the source  and the 
project,  and actual permit  values  requested and used, 
If a small  square  button  appears next to an  input, the button leads to 
more  detailed  information  about that input,  such  as a wizard for 
entering  latitude  and  longitude  coordinates or a  dialog box to edit the 
list  of  permit  holders,  etc. 

Of  particular  use  is the Quick List button, which brings up a table 
listing all the permits and estimates and allows the user to quickly find 
permits  already  entered in the system. 

Figure 4 - Quarry Permlt List 

Double  clicking on a row will open that permit in the quarry  permits 
form.  Right clicking on a field name will bring up a context  menu  that 
includes various sorting  options to reformat the list. 

3.2. Database Fields 
For  those  unfamiliar with database  terminology  a database, or Sable as 
it is  often referred to, is a  container for data  about a particular  subject, 
in this  case, granular resource  usage.  There  are two basic  elements in 
a database. Each category of information is called a field. Thus, a 
telephone book'has three fields:  name, address, phone  number.  Each 
set of information is called a record. For example, this entry in a phone 
book constitutes a record: 

Doe, John 13 Elm Street 5554321 

NORTH OF 60 ENGINEERING Lro. Granular Usage Database 0 9 
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DATA DESCRIPTION 

Permit # 

End user classification e.g, Private,  Government,  Military, Category 

Source  Code  Identification  Source 

Estimate,  Active,  Closed,  Inactive  Status 

Date the record was modified Date  Modified 

Company  responsible  for  permits  Permit  Holder 

Permit  Number 

Municipal 

Year of Usage 

Description of project Project  Description 

Year of extraction  and  placement 

LAT Location Latitude  (decimal  degrees) 

LONG 

Actual classification Actual  Class 

Actual amount  extracted  Actual  Requirements 

Requested class of material  Requested Class 

Requested  requirements  Requested  Requirements 

Estimated material classifications Estimate  Classification 

Most  LikelylRandomlPSO - the  value used in reports  Estimate  Default  Value 

High estimate of requirements  High  Estimate 

Likely estimate of requirements Most Likely  Estimate 

Low  estimate of requirements Low Estimate 

Company  that is extracting  gravel  Contractor 

Company  Sponsoring  the  Project Sponsor 

Location  Longitude  (decimal  degrees) 

Table 2 - Granular Resource Data  Base 

There are two basic arrangements for tracking  data. The telephone 
book is a tabular database. The information is arranged in a table of 
columns  and  rows.  Another way to look at the information  within the 
database is through forms, much like a card file or  Rolodex. The 

~. . .  
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el@ Granular  Resource  Forecast  Mod 
and  view  granular usage. 

uses  forms and tables to record 

The  granular  usage  database  contains  many fields of information  for 
each  record.  These  fields  are  summarized in Table 2 and discussed in 
detail  below. 

Quarry Permit #: Is the quarry  permit  number. 

Permit Holder: The  person or company that is requesting the 
permits. This would  generally be the person 
responsible  for the payment of royalties and 
meeting the conditions  of the permit. 

Date, Modified: This  represents the date the record was first 
entered  or  last  updated. It is entered  by the 
user. 

status: 

Source: 

Category: 

This is the status  of the specific  project. The 
user should enter one of the following 
depending on the stage  of  development. 

Estimate 
Active 

0 Inactive 

0 Closed 

The gravel source number/lD within the block. 

A descriptive  category  for the sponsor. NORTH 
OF 60 ENGINEERING LTD. recommends that a 
limited  number  of  categories be used.  Possible 
examples  are: 

Public 
Private 
Defence 

Year of Use: The year that the material was used.  Initially 
this would be an estimate, but would  change to 
reflect actual year of use. 

Project Description: A brief description of the project. 
Project Location: The location of the project.  Latitude  and 

Sponsor: The name of the individual  company or 

longitudes are recommended. 

municipality that is sponsoring the project. 

NORTH OF 60 ENGINEERING LTD. Granular Usage Database 0 I 1  
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Contractor: 

Low Estimate: 

Likely Estimate: 

High Estimate: 

Estimate  Default: 

Estimated Class: 

Requested Amount: 

Requested  Class: 

Actual Amount: 

Actual Class: 

The person or  company  actually  undertaking 
the quarry  operations. In many  cases, this 
would be the same as the permit  holder. 
A low side estimate of the amount of material 
to be required,  expressed  in  cubic  meters. 
A  likely  estimate of the amount of material to 
be  required,  expressed in cubic  meters. 

A high side  estimate of the amount of material 
to be required,  expressed in cubic meters. 

Value to use in creating  reports. The value is 
calculated based on a triangular distribution 
defined  by the low/likely/high  estimates  as 
described above. 

Mean/Most  Likely 

Random - random  value each time 

0 P50 - 50% probability 

An estimate of the required  class  of material 
(1-5). The specific classes are  defined in 
Appendix B of the User's  Guide. 

The amount of material requested at the time 
of quarry  permit  application. 

The  class of material requested  at  the  time of 
quarry  permit  application. 

The actual amount of material  used.  Generally 
speaking this would be based  on trip tickets  or 
an actual survey of the quarry  site at the end of 
the project, 
The actual class of the material used. 

3.3. Data Management 

Record Navigation Buttons 
The  record navigation buttons are used to scroll through the records 
on  a  form. Figure 5 shows the typical record  navigation  buttons in 
Microsoft  Access. Navigating to the next or previous  record is done by 
clicking on the arrow buttons.  Navigating to the first  or  last  record is 
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done  by  clicking on the  buttons  with  arrows and bars.  Creating a new 
record can be done by clicking on the button with an arrow  and  an 
asterisk "*". The record  number can also be entered in the text  box to 
navigate  directly to a specific  record. 

, , , , ,  """""""" , , .**.. , -."- 

Figure 5 - Record Navigation Buttons 

Adding, Updating or Deleting Records 

To Add a Record 

1. Display the Quarry  Permits  Form. 
2. Choose the New Button. 
3. Enter data in the new  record's  fields.  Press  TAB to move  between 

4. Repeat  steps 1 and 2 to add as many records  as you want. 
fields. 

To Delete a Record 
Note:  Deleted  records  cannot be restored. 
To delete a  record: 
I. Display the Quarry  Permits  Form. 
2. Display the record  you  want to delete. 

3. Choose the Quick List button. Make sure the record you want  to 

4. Push the DELETE  key  on the keyboard. 
delete is selected. 

To Find a Record 

1. Display the Quarry  Permits  Form. 
2. Select the field that you  want to search. 

3. Choose the Find command from the edit menu or the toolbar. 

4. Enter the criteria in the dialog box and choose Find Next. 

NORTH OF 60 ENGINEERING LTD. Granular Usage  Database 13 
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It may be easier to search the permits  by  sorting the quick list to 
display  the  permits in a specific  order. 

To Edit Records 

I, Display the Quarry  Permits Form. 

2. Locate  the  record to edit. 
3. Edit  each field you want to change.  Press TAB to move  between 

fields. TO cancel changes of a record,  press the ESC key on the 
keyboard. 

To Return to the Main Menu 
1. Choose the Close button when you are  finished  working in the data 

2. Alternatively,  choose the X button in the top right  corner  of the 
form. 

dialog box. 

Special Controls 
Some  fields on the Quarry  Permits Form have  special  controls that 
help  select and manage the data  entering in the field. These fields 
have  a small button beside them that will open a dialog  box to edit lists 
such as sources,  company  names and addresses,  block  areas,  or 
latitude and longitude DMS entry. 

View Data base 
To view  the  granular usage database in tabular  form, choose the 
Unhide command from the Window menu.  Select the database 
window  and  choose OK. Editing the tables  directly  requires  advanced 
skill in Microsoft  Access and Relational Database  Design. 

Backup Database 
To backup the database, copy the GRANULAR.MDB file to a floppy 
disk, CD or alternate folder. 

Compacting the Database 
As  records are modified and deleted the database  increases in size. 
Periodically  compacting the database is required to keep the database 
file small.  Choose the Compact & Repair Database command  from 
the Tools menu in Microsoft  Access. 

NORTH OF 60 ENGINEERING LTD. Granular  Usage  Database 0 14 
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3.4, Importing LIMS Data 
LlMS is an alternate  database that contains  granular  resource 
information that can be imported into the model. This is an advanced 
feature  that  requires  knowledge  of  Microsoft  Access  table  linking. A 
procedure  for  importing LlMS using the LIMSSAMPLEDATA.XLS 
worksheet  follows: 

1. Choose Import LIMS Data from the main menu. 
2. Choose Link  External Table from the dialog box that appears. 
3. A  file  open  dialog  box  appears.  Select the file that contains the 

LlMS data,  and  click on the Link button.  You  may need to change 
the file type to Microsoft Excel if the data is in a  spreadsheet. For 
this  example  look  for the LIMSSAMPLEDATA.XLS  workbook in the 
GRANMANUAL  folder. 

4. The Microsoft  Access  Link  Spreadsheet  Wizard  appears.  Select 
the  worksheet  or  named  range that contains the data  and choose 
Next. 

5. If asked to use  the first row as column headings, select the option 
and  choose  Next. 

6. tf  asked to enter  a table name,  use the default  name  given and 
choose Finish. The LlMS data  should be linked  to the application. 

7. When  back to the LlMS Import  dialog  box,  choose Next to add the 
LlMS data to the database,  or Cancel to return to the main  menu. 

It is extremely important that the LlMS data be formatted in a table 
like  the  data in LIMSSAMPLEDATA.XLS.  Particular  attention  should 
be made  to the field names in the sample file. 
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4. Analyzing Granular Usage 

- .. 

4.1 . Introduction 
~~ 

This  section of the  User's Guide describes the various  options 
available to the user to analyze data within the database. It also covers 
the  available  reporting  options. 

e 

4.2. Demand Analysis 
Actual vs. Forecast 
Selecting the Forecast Chart button on the menu  produces a graph 
showing the historical granular  usage.  The  graph  shown in Figure 6 
plots  estimated  requirements,  requested  amounts  and  actual usage. 
Over  time, this plot will tell whether initial estimates are high or low. 

Granular Forcast Quantities 

Figure 6 - Granular Resource Usage  Graph 
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Usage by Area 
Selecting the Quantities by Block button on the menu produces  a 
cross-tabulation of the database  showing the granular  usage by area. 
Figure 7 is an example  view of resource usage by area. 
For those  unfamiliar  with  cross-tabulations, or pivot tables as  they  are 
referred  to in Excel,  they  are a subset of the database  representing 
various  categories  within the database.' In this case, the pivot  table is 
summarizing the usage by year into the various  areas.  The table 
shows the years  along the side (row)  and areas across  the top 
(column).  The need and usage of this terminology will become  more 
evident. 

Permit Quantity Summary by Block 

! 

Figure 7 - Granular Resource Usage by Area 

Usage by Source and Quality 
Selecting the Quantities by Material Class button on the menu 
produces a cross-tabulation of the database  showing the historical 
granular  usage  by  source and class of material. In this pivot table, the 
sources  are listed by page (each page is one source) and the class of 
material along the top  (column). 
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User Defined Analysis 
The  pivot  tables can be  modified to filter the data. The modifications 
are not  permanent  and will be reset the next time the application is 
opened.  Proficient  knowledge of Microsoft Excel pivot tables is 
recommended  when  modifying the pivot table reports. 

Report All Records 
Selecting the All Records button on the menu produces a report with 
table  listing  each  permit  and  estimate that is entered into the 
database.  The table shows each field that is available for each  record 
and is formatted to print on tabloid sized  paper. 
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Appendix A = Program License 

The  Granular  Resource  Forecast Model Q is copyrighted  by  NORTH OF 
60 ENGINEERING  LTD. and  licensed to the Department of Indian  and 
Northern  Affairs and the lnuvialuit Land Administration  pursuant to the 
general  conditions  set out in document 1632-99-0450. Users of this 
model  may  not  make  any use of Software that is not expressly 
provided  for in the general  conditions. ' 
NORTH OF 60 ENGINEERING  LTD. shall, for a period of 90 days from the 
date of delivery,  replace  any  diskette on which the Software  is  supplied 
which is defective in material or  workmanship  under  normal  use. 
NORTH OF 60 E NEINEERING LTD. does not  make  any  representations 
regarding  the use, or the results of use, of the Software  or 
Documentation in terms of correctness or otherwise. The entire  risk as 
to the results and performance  of the model is assumed  by  the user. 
NORTH OF 60 ENGINEERING  LTD. specifically  disclaims all other 
warranties,  expressed  or  implied,  including but not  limited to any 
implied  term,  cqndition,  representation  or  warranty of merchantability 
or  fitness  for a particular  purpose, that the model will meet  your 
requirements, that the operation of the model will be uninterrupted or 
error  free,  or  that  our  maintenance will remedy  any error, deficiency or 
other bug encountered. 
Information in this Model is subject to change  without notice and does 
not  represent a commitment on the part of NORTH OF 60 ENGINEERING, 
LTD. 

NORTH OF 60 ENGINEERING LTD. Appendix A 0 21 



Granular Resources Forecast 
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Appendix B = Granular Material Types 

CLASS 

I 

2 

3 

4 

5 

MATERIAL DESCRIPTION 

Excellent  quality material consisting of clean,  well- 
graded,  structurally-sound  sand  and gravel suitable for 
use as high-quality (e.g. runway or roof) surfacing 
materials, or as asphalt or concrete  aggregate,  with  a 
minimum of processing. 

Good quality material generally  consisting of well- 
graded  sands and gravels  with  limited  quantities of silt. 
This material will provide good quality  base  and 
surface  coarse  aggregates or structure-supporting fill. 
Production of concrete aggregates  may be possible 
with  extensive  processing,  except  where  deleterious 
materials are present. 

Fair  quality material consisting  generally of poorly- 
graded  sands and gravels  with  or  without substantial 
silt  content.  This material will  provide fair quality 
general fill for  roads,  flexible  foundation  pads,  or 
staging  areas. 

Poor  quality material consisting of silty,  poorly-graded, 
fine  grained  sand, with minor  gravel.  May also contain 
weak particles and  deleterious  materials and- are 
considered  suitable  only  for  marginal, general (non 
structural) fills. 

Bedrock of fair to good quality,  felsenmeer  or  talus. 
Potentially excellent sources of construction  material, 
ranging from general fill to concrete  aggregate or 
building stone if quarried and processed. Also includes 
erosion control materials  such  as  rip-rap or armour 
stone. 
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